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• Lesson 1: SOLIDWORKS Multibody Design Techniques 
• Lesson 2: Saving Solid Bodies 
• Lesson 3: Sketching with Splines 
• Lesson 4: Introduction to Sweeping 
• Lesson 5: 3D Sketching and Curve Features 
• Lesson 6: Threads and Library Feature Parts 
• Lesson 7: Advanced Sweeping 
• Lesson 8: Loft and Boundary Features 
• Lesson 9: Advanced Loft and Boundary Features 
• Lesson 10: Advanced Filleting and Other Features 

 
 
 

Disclaimer: This document is a comprehensive summary of critical key takeaways from 
lessons within SOLIDWORKS Advanced Part Modeling offered by GoEngineer. This 

document should not be considered a substitute for an official SOLIDWORKS training 
course. 
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Lesson 1: SOLIDWORKS Multibody Design 
Techniques 
 
Multibody parts have two or more continuous solids in the same part file. Usually 
used to end up with a single body design, they can also be used in place of an 
assembly.  
 
Set to 'show' to always see the folder, or 
'automatic' to show the folder only when two 
or more bodies are present. You can also access 
this by right-clicking the top of the FeatureManager Design Tree to find 'Hide/Show 
tree items'. 
 
 
Creating Multibodies 
 
Here are some common ways multibodies can be 
created:  
 

• Creating bosses from disjoint features 
• Creating a boss that is separated by a 

distance from other bodies 
• Creating a boss with the 'merge result' option 

cleared 
• Creating a cut that results in multiple bodies 
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Bridging 
 

When Boss Extrudes share a volume 
and the 'merge result' option is on, all 
bodies that touch will become one. 
 
 
 
 
The center extrusion allows the other 
four bodies to all merge at once. 
 
 
 
 
 
 

 

Tool Body or Insert Part 
 

o When inserting a part into another part, it will act as a solid body. You can also 
choose whether or not to maintain the link (i.e., external reference) to the 
original file.  

o Click OK to align the inserted part's origin to the active part's origin. Otherwise, 
click to manually place it where you desire. 

o Choose the entities to transfer in with the body.  
o Optionally, check the box to locate the body afterward using a Move/Copy 

feature. 
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Move/Copy Bodies 
 

You can manually 
move the body by 
rotating or 
translating on the 
translate/rotate 
tab. You can use 
mates to align the 
bodies on the 
constraints tab. 

Click the button at 
the bottom of the 
command to 
switch between 
these options. 
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Combining Bodies Using Combine 
 
When we have bodies that we need to join, 
we can use the Combine command and 
choose from three options: 
 

o Add - The selected bodies will form 
one solid by combining the volumes. 

o Subtract - Removes selected body 
volumes from a 'main' body. 

o Common - Uses only the volumes 
common to all the selected bodies. 
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Intersect  
 

Creating new bodies or 
merging bodies can also be 
done using Intersect. This 
tool allows you to use Solid 
Bodies, Planes, and Surface 
Bodies to create your end 
result. 
 
Select the regions to 
exclude, or select the regions 
to keep and invert the 
selection. The preview shows 
the desired end result. 
 
 

 
Indent  
 
The Indent feature uses one body to reshape the walls of a target body.  
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The keep or remove selections will determine the direction of the wall offset. Set the 
wall thickness and any needed offset from the tool body to get the desired results. 

 
 
Finally, use the 'Delete Bodies' option to remove the tool body/bodies from the 
model, avoiding the need to delete it later with the Delete/Keep Bodies command. 
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Lesson 2: Saving Solid Bodies 
 
When working with multibody parts, sometimes it is useful to turn a body into a 
separate part file. This can be for modeling convenience or for BOM accuracy. 

Insert into New Part 
 
The 'Insert into New Part' command allows 
you to create new parts from any or all bodies 
in the Solid Bodies folder. The command is in 
the Context Menu when you right-click the 
Solid Bodies folder or a body inside of it. The 
resulting files are linked to the original part 
file, so all changes there will propagate to the 
new part. 
 
The new parts can then be used in assemblies, or anything else. 
 

Save Bodies 
 
Save Bodies also lets you save bodies as separate 
files, by right-clicking the Solid Bodies folder in the 
FeatureManager Design Tree. 
 
Select the bodies from the list (or the graphics area) 
to mark them for save. Unlike 'Insert into New Part', 
Save Bodies creates a Feature in the tree, so any 
features below will not propagate to the new files. 
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Split 
 
The Split Feature allows a part to be cut into multiple bodies 
without taking any material away. The Split tool can be a 
Plane, Sketch, Face, or Surface Body.  
 
After selecting the Trim Tool and clicking 'Cut Part', you can 
select the resulting bodies to be split and then saved 
externally or left as separate bodies in the current file.  
 
The resulting files are linked to the original as well. Since Split 
creates a Feature, any Features below that in the tree will not 
propagate to the new files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

888.688.3234 | GOENGINEER.COM                                                   

Lesson 3: Sketching with Splines 
 
Splines (also called curves) have a constantly changing curvature and come in a variety 
of types, each offering a unique way to create and manipulate them.   

Using with Sketch Pictures 
 
One really good way to reproduce something is to insert 
a picture of it into the Sketch, scale it to the right 
proportions, then trace the edges.  
 
In a Sketch, use the Tools > Sketch Tools > Sketch Picture 
command and then scale using the X and Y dimension 
boxes in conjunction with the scale tool. Position by 
dragging and using the X and Y position boxes.  
 
Transparency can also be used to help hide parts of a 
picture you don't want visible. The user-defined option 
allows you to select a color from the image, then set the 
percent of transparency. 

Creating the Spline 
 
When sketching Splines, it’s best practice to use as few points as possible. This helps 
the spline curvature stay smoother and extra spline points can be inserted as needed. 
Usually, a new point is only needed for additional changes in curvature and to keep 
the spline where it needs to match the geometry. 
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Spline Manipulation from RMB Context Menu 
 

o Insert Spline Point adds another point to the curve/polygon to help shape 
the spline 

o Show Spline Handles allows manipulation of the spline by dragging the 
direction and magnitude of the shape influence 

o Display Control Polygon allows shaping the spline and keeping it in the 
simplest form; drag the vertices to shape the spline 

o Show Curvature Combs shows the curvature in lines that illustrate the 
smoothness of the curve 

 
Spline Relations 
 
Splines aren't the same as most sketch entities when it comes to adding relations, but 
they are compatible with Tangency, Equal Curvature, and Torsion Continuity. These 
relations help with blending curves together for a smoother transition.  
 
Spline handles can be used to add relations, including Horizontal, Vertical, and others as 
vector-related relations. In the above image, the Vertical Relation (far left center) is a 
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good example, but note that the curve itself may cross the vertical to maintain curvature 
as the Spline is adjusted elsewhere.   
 
Style Spline  
 
Style Splines are splines created by making points that surround the Spline, not points 
on the curve. This is very similar to the control polygon of a typical spline. The style 
spline then creates points and construction lines which can be used to add dimensions 
and relations to help define the spline and its curvature.

 
Fit Spline  
 
Fit Spline is used to convert multiple entities to a single spline. It is sometimes needed 
so there is a single entity, but it is best used for creating a smooth transition between 
entities.   
 
Fit Spline is also the easiest way to control a spline dimensionally.  
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Spline Creation and Manipulation Best Practice 
  
There are many ways to create and then manipulate a spline to get the desired result: 
 

o Create Construction Geometry: Centerlines and such are great tools to help 
you get your overall shape and size 

o Sketch your spline: Remember to keep the points minimal at this step for 
smoothness 

o Add sketch relations: Constrain the curve where needed by adding Relations 
to the Spline or the spline handles 

o Move the Spline points and use the control polygon 
o Drag the Spline handles to manipulate the shape (these last two steps may 

need to be repeated several times) 
o If necessary to get the proper shape, insert another spline point and readjust 
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Lesson 4: Introduction to Sweeping 
 
Sweeps are features that have a profile and path that 
can be either bosses or cuts and simple or complex. 
 
The path can be 2D sketches, 3D sketches, curves, and 
model edges. 
 
The 2D profile can be a sketch, a face of the model, 
or a circle with the diameter input inside the feature 
(the circular profile option doesn't require a sketch). 
 
Sketched profiles require a single sketch. This sketch 
must be closed and have no self-intersecting 
contours. Multiple contours are OK; these can be 
nested or disjoint to create a variety of shapes. 
 
Best practice is to sketch the path, then attach the 
profile sketch to it using a Pierce relation. 
 
You have the option to use Guide Curves, Control Twist, and set the Start/End Tangency. 
 
SOLIDWORKS then creates the Sweep by replicating the profile at various positions 
along the path and then blending them together. 
 

Guide Curves with Sweeps 
 
In create more complex sweeps, or simply help with twist, Guide Curves can be created 
and used in the sweep. 
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For creating this bottle, for example, we 
used an ellipse as the profile. A straight 
line (vertical) was used as the path. The 
two guide curves were used to shape 
the sweep. 
 
The result is a suitable bottle without 
creating many profiles or taking much 
time. 
 
The top was also dimensioned to ensure 
the top would be a true circle so we 
could later use that shape to form the 
neck. 
 
 
 
 
 
 
 
 
Multi-Thickness Shells  
  
After defining the primary wall thickness, you can then pick specific faces that will 
require a different thickness. (Note: The command requires that multi-thickness faces 
meet at a sharp edge.) 
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Selection Manager  
 
The Selection Manager allows portions of edges/sketches to be used/re-used for many 
features. In our case, we used only part of a sketch for the path. The other part of the 
sketch was then used as a guide curve. 
 
Some selection sets will automatically open the selection manager, while others will 
require you to RMB to access it. 
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In the bottom row, you can 
choose from closed loop, 
open loop, group (a 
combination of picks), 
regions, and normal 
selection. 
 
Once the desired selections 
are made , hit the to 
accept the 
selection set. You can also 
cancel or clear the selection 
from the buttons in the top 
row. 
 
This allows the path and the 
guide curve to be all in one 
sketch and easier to manage 
and create. This is especially 
true if the geometry is 
similar. 
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Lesson 5: 3D Sketching and Curve Features 

3D Sketching 
 
3D Sketches are similar to 2D Sketches, but with a few 
noticeable differences.  You will see the cursor change 
when the Tab key is pressed.  
 

o XY – normal to the Front plane 
o YZ – normal to the Right plane 
o XZ – normal to the Top plane 

  
 Pressing the Tab key cycles through these. 
 
You can also create an Offset Plane by clicking a plane, holding down the CTRL key, and 
dragging the mouse. Double-clicking in space will release the Sketch plane, going back 
to 3D Sketch mode.  
 
When not locked onto a 
face or plane you will also 
see the 'Along X' (or Y or 
Z) relation instead of 
Vertical and Horizontal. 
 
Many familiar relations 
are slightly different in 3D 
Sketches. 'Parallel to 
plane', 'on plane', etc. are 
important to master in 
order to define your 3D 
Sketch accurately. 
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Helix/Spiral 
 
A Helix/Spiral uses a circle to determine the starting 
diameter and location. You can then set the options based 
on pitch, height, and number of revolutions. 
 
Other options are reversing the direction, setting the start 
angle, and clockwise/counterclockwise. Once completed, 
you will have a 3D Helix or a 2D Spiral. 
 
Many times, a Helix is used for cutting or adding threads, 
but there are many other uses for them.   
 
 

 

 

Projected Curve 
 
Projected Curves use Sketches to either project into 
another Sketch or onto the face/faces of the model. 
 
'Sketch on Faces' will project the Sketch to the faces 
in the direction it’s projected. 
 
'Sketch on Sketch' will project the Sketches together, 
keeping only the geometry common to both, where 
they intersect. 
 
The resulting curve might be very difficult if not 
impossible using normal 3D Sketch tools. 
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Composite Curve 
 
Composite Curves combine Curves, Sketches, and/or model edges into a single curve. 
This can be very important, as some features will require a single entity to be used in the 
selection set.  
 
To use, simply select the geometry desired and hit OK.  
 
In this case, the sweep using the Composite Curve wasn’t exactly as smooth as could be. 
To correct that, use a 3D Sketch and convert entities to copy the curve. Then use Fit 
Spline to get a better transition between the 3D Sketch and the Helix.  
 
The part (or even the 3D Sketch) can be mirrored to complete the body. The profile for 
the sweep was set to 'circular' with the proper diameter. 
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Lesson 6: Threads and Library Feature Parts 

Library Feature Parts 
 
Library Feature Parts are a great way to save and reuse data. They can be as simple as a 
Sketch for a profile, (e.g., weldments and threads) or a series of Features. To accomplish 
this, ensure the Sketch is selected, then Save As, and choose 'Lib Feat Part (.sldlfp)'. 
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If done correctly, the sketch should have an “L” 
symbol on it, as shown below. If not, RMB the Sketch 
and choose 'Add to Library'. If the Sketch is not set 
as the Library Feature, SOLIDWORKS will try to insert 
this as an entire Part, not just the Sketch. The same 
functionality applies if you are trying to use Features.  
 
If you are making a thread profile or weldment 
profile, make sure you save in the proper location. 
You can find this under Options > System Options > 
File Locations and then selecting the proper type. 
Failure to save in the right location will result in not 
being able to use the file. 
 
 
 
Threads  
 
When making a thread, remember the default pierce 
point will be the origin. You can also set a default 
pitch by creating a horizontal centerline beginning at 
the origin. 
 
When using the Thread Feature, you need to select 
the Thread Profile and a start circular edge. The edge 
will be used to create the Helix based on the other 
parameters you choose (e.g., pitch, revolutions, etc.). 
Use End Condition, Specification (size, pitch), and 
Thread Options to get the desired result. The profile 
can be rotated and mirrored as well. 
 
When inserting Library Features, we are often faced 
with a series of selections like planes and edges. We 
can understand these by looking at the Sketch and 
then understanding that Sketches always require a 
Sketch Plane. 
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In Sketch Mode, choose display/delete relations. You can then change the 
filter to 'external'. This will let you know what entities in the Sketch refer to 
something outside the Sketch such as points, edges, and planes. Now you 
will know when you use the Sketch as a Library Feature what it will be 
looking for. 
 
Once you have created the Library 
Feature you can also set up locating 
Dimensions. This will help with 
positioning and resizing the Library 
Feature without having to edit the 
Sketch(s). 
 
Drag any of the dimensions to the 
Locating Dimensions folder. You can 
also drag dimensions to the Internal 
Dimensions, so they are not available to 
modify when inserting the Library 
Feature. 
 
Split Line 
 
Split Line Features are curves that 
create edges or faces on the surface of 
a model. It will create edges but will 
not change the geometry of the part. 
 

o Silhouette – projects the outside 
of the part to a face or plane 

o Intersection – projects the 
outside of the part where a plane 
or surface body intersects 

o Projection – projects a sketch or 
curve onto the face of the part 
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Lesson 7: Advanced Sweeping 

Profile Orientation 
 
Since Sweeps are created by blending intermediate sections of a profile at various 
positions along the path, it is important to understand how the orientation of the 
intermediate profiles are controlled.  
 
We can think of the profile orientation in terms of Pitch, Yaw and Roll. The Pitch and 
Yaw are defined by the orientation of the profile to the path. The Roll is the twist or spin 
of the profile around the path. 
 
We can either use the Twist Options or Guide Curves to control the Roll.  
 
In our case study, we found that using the default Profile Orientation (“Follow Path”) did 
not maintain our design intent of 5.00° of draft.  
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Once we changed the Orientation to “Keep Normal Constant”, we had the desired effect. 
The reason for that is that Keep Normal Constant keeps the intermediate profiles 
parallel to the original. “Follow Path” allows the profile to Pitch/Yaw to match the 
original angle between the path and the profile. In this case, the profiles would remain 
perpendicular to the path.  
 
We were able to use Intersection Curves in a sketch to get the intersection of a plane 
and faces. We could then measure and found it to be < 5.00°.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(Another way to preview how the intermediate profiles would rotate is by using face 
curves in a 3D Sketch: Start a 3D Sketch, turn on Face Curves and select a face.)  
 
Controlling Twist 
 
When a sweep twists by default, you can use the options to control or minimize the 
twist. For this part with a significant twist (left), we’ll minimize it (right). 
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Changing the Profile Twist to “Minimum” did not fix it, so we 
were able to use the Specify Direction Vector. In this case we 
used an Axis, but we could have used a plane instead.  
 
In other cases, you may want to specify the twist value, 
creating twist when there would have been none.  This is a 
great way to create twisted items without having to create a 
helix first.  
 
Undesired twist can often be caused by relations in the profile 
sketch; Horizontal and Vertical relations are the usual 
suspects. If you think about it, the orientation of “vertical” and 
“horizontal” may change as the sketch profile moves through 
space.  
 
To keep this from happening, you can use pierce, parallel and 
perpendicular instead. If that is not achievable, you will need 
to create guide curves. These would be normal candidates for projected curves as well.  
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Align with End Faces and Model Edges Sweep Path 
 
When going through the Sweep Options, you may notice “Align with end faces”. This is 
particularly useful when using keep follow path, which is the orientation for a circular 
profile. 

 
 In this case “Align with end faces” extends the cut all the way to the end face.  
 
If using model edges to define the path, make sure to use the Selection Manager, as the 
field will only pick the first edge you pick by default. This means you don’t need to 
recreate the edges as a sketch.   
 
Sweeping with a Solid Profile 
 
Instead of a sketch profile, you can use a separate 
body for a Swept Cut, then select the body and the 
path as usual. 
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The resultant cut would be much harder to create as a normal Swept Cut, particularly 
the end of the cut.  
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Lesson 8: Loft and Boundary Features 

Loft vs Boundary Features 
 
Lofts are used to blend multiple profiles of different shapes. They can use Guide Curves 
and even a Centerline. However, control is limited to the beginning and end profile 
orientations. 
 
Boundary Features offer all the 
same options as a Loft, plus the 
ability to control intermediate 
profiles and the use of other 
directions (guide curves). However, 
it doesn't have centerline control 
and can lead to greater rebuild 
times. 
 
Both connect points in the profiles 
to the coinciding point on the next 
profile. If you click near a point, it 
will snap to the closest point. If you 
don’t have points, like a circle, it is 
difficult knowing where the 
connections will be. You can 
manually tweak the connectors. 
Remember to pick profiles in order 
or use the blue arrows to change 
the order. 
 
Other options include "Thin 
feature" and "Merge tangent 
faces". 
 
It is more common to use Lofts, but as you can see, both Features are very similar. 
 
Loft and Boundary Features on Solid Bodies  
 
When creating a transition between faces on a model, both Features do a great job. 
Select the end faces, then set the constraints (you can even adjust the Start Tangent 
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Length by typing another number or dragging the arrows in the graphics area). Not only 
is this fast, but it easily does things that are difficult with normal lines, arcs, etc. 
 

 
 
Derived and Copied Sketches 
 
Copying and pasting works the same way with a Sketch as it does a file. The new Sketch 
is not linked to the original.  
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But with a Derived Sketch, you get an exact, linked, duplicate. You are able to locate 
and/or re-orient the sketch, but it won't have dimensions or relations to edit. 
 
To create a Derived Sketch, select both the Sketch to copy, and the plane/face to paste 
to. Then click "Insert > Derived Sketch". You will now be editing the new Sketch. 
 
Remember, any changes to the original will affect the Derived Sketch, but not a copied 
and pasted Sketch. 
 
Modify Sketch 
 
Modify Sketch allows you to 
move, rotate, scale, and 
mirror a sketch. You can use 
the dialog box or use the 
mouse to drag and move 
(LMB) or rotate (RMB). Using 
the black manipulator icon, 
you can also mirror by right-
clicking on the spheres. The 
three spheres have different 
mirror options, and one 
should do exactly what you 
need. 
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Lesson 9: Advanced Loft and Boundary Features 

Using Secondary Curves 
 
Lofts and Boundary Features both allow use of secondary curves. For Lofts, they’re called 
“Guide Curves”; Boundary Features are added as “Direction 2”.  
 
Secondary curves have more influence on the overall shape of Lofts, whereas with 
Boundary Features, both direction 1 and 2 can have equal influence. This is part of how 
you can get different results between the two features.  
  
Lofts, however, also allow for the use of a centerline. 
In our example, we used this option to control how 
the intermediate profiles were blended.  
 
 
 
 
 
Profiles and Segments  
 
When using Loft or Boundary Features, the way the profiles line up is determined by the 
points you click (on or near) while selecting them. When profiles have different numbers 
of segments/vertices there may be undesired results. Creating a new profile with the 
same number of segments will fix this. You can use the Split Entities sketch tool to split 
profiles such as arcs to get the total number of segments (and thus points) to be the 
same. Note the difference when the number of segments is equal as shown below. 

 
You can also manually adjust the way the profiles come together by using “Show all 
connectors” from the context menu, then dragging them around. Be aware this isn’t as 
precise but is more of a drag-and-drop-as-close-as-you-can sort of tool. 
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Curve Influence  
 
In this example, we used an ellipse in each profile Sketch and splines 
in the middle to model a hook two ways. For this part, one of the big 
differences between the Loft and Boundary was the Curve Influence.  
 
The Loft Feature has limited options for how we can apply tangency control to the guide 
curves, while Boundary has all the same options for Direction 2. This can result in some 
noticeable differences between the two features. Which to use in practice will depend 
on your part’s geometry. The differences are more noticeable when the “Show 
Curvature” option is enabled, to get a color representation for changing curvature.  
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Lesson 10: Advanced Filleting and Other Features 

Fillet Method and Fillet Type 
 
There are four Fillet Types: Constant Size, Variable Size, Face Fillet, and Full Round. 
Though the Constant Size with “Symmetric” method is most common, each of these fit 
certain applications, and thus there is no one-size-fits-all fillet.  
 
Fillet methods are Symmetric, Asymmetric, Chord 
Width, and Hold Line. Symmetric means that the X and 
Y distances will be equal. Asymmetric, naturally, means 
X and Y are not equal. Chord Width refers to the 
distance between the ends in a straight line. Hold Line 
uses model edges to determine the radius and 
tangencies.  
 
 

o The “Symmetric” method is available for Constant Size, Variable Size, Face 
Fillet and Full Round 

o Asymmetric is available for Constant Size, Variable Size, and Face Fillet 
o Chord Width and Hold Line are only available for Face Fillets 
  

Setback Parameters and Multiple Radius 
 
Setback Parameters are 
used to define how far 
away from a common 
vertex three or more fillets 
begin to blend. This can 
result in a much different 
look despite using the 
same radius. 
 
 
 
 
You can also set multiple radius values in the same fillet command. These options are 
only available for Symmetric fillets however. 
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In our example, a Delete Face Feature (with “Delete and fill,” and “Tangent fill” options 
enabled) was used to smooth the altered fillet.  
 
 
Keep Features 
  
Another Fillet Option for Constant Size Fillets is “Keep Feature”. This defines whether or 
not existing Features in the model should remain if the new Fillet completely surrounds 
them.  
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Variable Size Fillets 
 
Variable Size Fillets allow you to create more complex fillets where the radius differs 
along the way. This example also shows that the Fillets radius can be zero. You can also 
choose to have Symmetric or Asymmetric fillets, as well as changing the profile shape 
(the default profile is Circular). The number of points is three by default, but that can 
change. The selectable points are shown along the edge, along with the size of each 
radius in the graphics area.  
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Face Fillets 
 
Face Fillets are created between faces instead of edges. These are usually used when 
edges have problems, such as when the edges are broken by other features. They also 
can help remove faces from “dumb solids”.  
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Face Fillets also allow the use of a “Hold Line”. This will create a fillet tangent to the 
selected faces and the radius will be automatically adjusted so the Fillet ends at the Hold 
Line edge(s).  
 

 
 
FilletXpert 
 
FilletXpert allows you to add multiple sizes of 
Constant Size Fillets, change sizes, remove 
existing Fillets, and modify the corners where 
fillets blend - all in one tool.  
 
Use the “Add” tab add Fillets by picking an 
edge, using the Selection Toolbar to quickly 
select multiple related edges, and click Apply. 
Adjust the fillet size as needed, select more 
edges, and Apply again. Use the “Change” tab 
to modify the radius values of existing Fillets 
and remove any unneeded Fillets from edges.  
 
The “Corner” tab allows you to choose between 
different blend options where three Constant Size Fillets of mixed convexity come 
together.  
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Wrap 
 
The Wrap Feature takes a sketch and wraps around a non-planar face. You can choose 
to add material, remove material, or split the face(s).   
 
Select the proper Wrap Type, which specifies whether your face is round or a spline 
surface. Then pick the Sketch and the face to apply it to; set the depth of material to add 
or subtract and Pull Direction if desired.  
 

 
 
Deform 
 
The Deform tool lets you modify an existing body 
by using a “Point”, “Curve to curve”, or “Surface 
push”.  
 
“Point” was used on our model in a 3D sketch. 
We set the Radius and Height and Deform 
Distance as well. The “Deform Region” option 
kept the shape change limited to the face the 
point was on. “Maintain Boundary” was also 
enabled to keep the edges of the face as they were.  
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“Curve to curve” was used to modify the edge of 
the model as well, to conform to the Sketch as 
shown.  
 
The face in purple was set to “fixed” to ensure 
that the face didn’t change due to the new 
deform. Note: This fixed entity is not allowed to 
be touching the initial curve.  
 
You can also change the Shape Options 
accuracy slider if the result isn’t accurate 
enough.  
 
 
 
 
 
 
 
 
A “Surface Push” was used to create the last deform 
area.  
 
After making a copy of the two top faces that merge 
(using the “Knit Surface” Feature), the other Sketch 
was extruded to the far side of the new surface with 
an Extruded Boss.  
 
The “Merge result” checkbox was cleared to keep 
the new body separate.  
 
The faces on the top were set as the Deform Region, 
ensuring only those faces would be modified. We 
used the “Select Body” option and picked that body, 
then set the deform deviation.  
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Move Face 
 
Move Face can be used to modify files with or 
without Features. This can allow even a native 
SOLIDWORKS file to be modified with ease, no 
matter how many features were used to create the 
end result.  
 
You can “Offset”, which has different results for 
planar vs cylindrical faces, “Translate”, or “Rotate” 
the selected face(s).  
 
Either enter a distance value or drag the face(s) to 
the desired location.  
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